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Quick Start Guide

AutoPatch RGBHV to DVI-D Converter

Overview

This guide contains complete information for the RGBHV to DVI-D Converter when it is
used as a standalone unit. For additional information on using the converter in
conjunction with an AMX AutoPatch Distribution Matrix, see the Instruction Manual for
the router on the AMX AutoPatch CD or at www.amx.com.
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FIG. 1 RGBHV to DVI-D Converter FG1010-09-01
Specifications
General Specifications

Approvals CE, UL, cUL

Power*
Consumption (max.) +12VDCto+24 VDC @ 1.3 A
Connector 2.1 mm DC power jack

Operational Temperature 32°to 110° F (0° to 43° C)

Humidity 0 to 90% non-condensing

Maximum Resolution 1600x1200 @ 60 Hz

Supported Cable Types HD-15, DVI-D

Dimensions 5.15in. (13.08 cm) depth
4.33 in. (11.00 cm) width
1.66 in. (4.22 cm) height

Weight Approximately 1.5 Ib. (0.7 kg)

DVI Output Specification DVI-D 1.0 (single link)

Video Specifications

RGB Input Level 1 Vpp (max.)

HV Sync Input Level TTL compatible

RGB Input Impedance 75 ohms

DDC/EDID Support Provided by converter

* RGBHYV to DVI-D Converters use a power supply that is provided with the unit.

Installation

Mounting Options
Rack Trays & Mounting Brackets — contact your AMX representative for details.

System Setup

A typical setup using an RGBHYV to DVI-D Converter as a standalone unit is illustrated
in FIG. 2.
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FIG. 2 Typical setup for an RGBHV to DVI-D Converter

Cabling the Converter

Before installing in a permanent location, we suggest placing the equipment close
together so the Control PC and the Destination Monitor can be seen simultaneously
during fine tuning.

To attach connectors & power to the converter:

1. Plug the power supply into the power jack on the converter and into an external
AC power source (FIG. 3).
If you are providing the power supply — Plug the power cord from a UL
(or equivalent) listed power supply into the power jack on the converter (FIG. 3).
The electrical ratings must meet those indicated in the specifications table.

2. Attach one end of the USB (Mini-B) cable to the running Control PC (see the
“Equipment & Requirements” section below) and the other end to the converter
(FIG. 3). Windows should recognize the new device as an HID device and install
default drivers.

USB(Mini-B) HD-15
FIG. 3 Attach connectors & power to converter
3. Attach one end of the HD-15 cable (pinout in FIG. 4) to the Source PC and the
other end to the converter.

4.  Attach one end of the DVI-D cable (pinout in FIG. 5) to the Destination Monitor
and the other end to the converter.

DVI-D

Converter’s HD-15 Pinout
The HD-15 connector on the converter uses the pinout in FIG. 4.
Input (VESA DDC Compliant)

1. Red 6. Red GND 11. 1D Bit

2. Green 7. Green GND 12. DDC SDA

3. Blue 8. Blue GND 13. Horizontal Sync
4. IDBit 9. +5VinDDC 14. Vertical Sync
5. GND 10. GND 15. DDC SCL

FIG. 4 HD-15 input pinout for converter

Converter's DVI-D Pinout
The DVI-D connector on the converter uses the pinout in FIG. 5.
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1. Data 2- 9. Data 1- 17. Data 0- C1. No connect

2. Data 2+ 10. Data 1+ 18. Data 0+ C2. No connect

3. Ground 11. Ground 19. Ground C3. No connect

4.No connect  12. No connect  20. No connect C4. No connect

5. No connect  13. No connect  21. No connect C5. No connect * i

6. DDC-CLK 14. +5V* 22. Ground The +5VDC on.pln 14
7.DDC-Data  15. Ground 23. CLK+ will supply a maximum of
8.

No connect  16. Hot-Detect ~ 24. CLK- 55 mA.

FIG. 5 DVI-D output pinout for converter

Equipment & Requirements for Video Adjustment with Wizard
The RGB-DVI Wizard software (provided on CD) must be used to configure RGBHV to
DVI-D converters. One of the provided preset configuration files can be downloaded or
a custom one can be created and downloaded. The factory default configuration is
1024x768 at 60 Hz. Once a new configuration is selected or is created and saved, it
becomes the default.

Control PC with Monitor (for installation only)

+  Windows 2000® or Windows XP Professional®, 2 MB free disk space,
15 MB RAM, USB 1.1 controller and port
* Runs RGB-DVI Wizard, which adjusts configuration of display settings
Source PC (or any other RGB video source)
» Video card that supplies analog RGBHYV at one of the EDID supported
resolutions* (see chart below)
*Determine which resolution before attempting to adjust video display; see the reverse
for directions.

Supported Resolutions & Refresh Rates

Resolution Refresh Rate i

Note: Other resolutions may

640x480 60 - 85 Hz be supported; try the directions
for “Specialized Resolution

800x600 60-85Hz Adjustments” and for “Fine

1024x768 (factory default) 60 - 85 Hz Tune Adjustments” on the
reverse page.

1152x864 60 - 85 Hz

1280x768 60 - 85 Hz

1280x960 60 - 85 Hz

1280x1024 60 - 75 Hz max.

1600x1200 60 Hz max.




Destination Monitor or Device

* Adjustments made with the Wizard are seen on the destination monitor or
device.

RGB-DVI Wizard (with Help file)
« Install on the Control PC (see Step 2 of “To adjust the video display”).
Optional — Adobe Acrobat

* Use to view supplied test images (<installation folder>\Test Patterns) for
checking resolution, color, and phase timing.

To determine Source PC's video card resolution/refresh settings on
Windows® operating systems:

Minimize all applications on the Source PC.

Right click on the desktop.

Select Properties from the Shortcut menu.

Select the Settings tab in the Display Properties dialog box.

Check the Screen area setting (resolution).

Click Advanced, and select the Monitor tab.

Check the Refresh Frequency, expressed in Hz (try other tabs if not visible).
Click Cancel on each dialog box to exit.
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Video Display Adjustment
Tips for Working with Video Displays

» CRT monitors seem more sensitive to losing sync when changing vertical
position.

*  “ReSync Monitor” (CTRL-R on the Control PC) can be useful when
closing in on final settings. Sometimes re-syncing clears up small
irregularities in display. As long as the adjustments are in the acceptable
range for the Destination Monitor, the sync light will shine constant a few
seconds before the image reappears. If the sync light does not shine
constant, return to the previous settings.

* Watch the sync / no sync light on the Destination Monitor. Dramatic
movements in a setting can cause the monitor to go blank temporarily
because it loses sync.

Test Image Files
Test image files (for checking resolution, color, and phase timing) are provided on the

AMX AutoPatch CD. The test image files are copied to <installation folder>\Test
Patterns on the Control PC when the Wizard is installed (Step 1 below).

We recommend the following sequence for using the Wizard to adjust the video
display on Destination Monitor and save the settings as a User Configurable Preset.
Note: The Destination Monitor controls may need adjusting during this procedure.
To adjust the video display:

1. Using the Control PC — on the AMX AutoPatch CD, run the BoardConfig.exe
file located at CDRDrive:\Configuration\BoardConfig.

|7~ RGB-DVI Wizard
Fie Edit Options View Help
» ®EB @
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Harizantal Vertical Fire Tune  Phase Timing
Position Position
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Changes R+G+B channel DC offset.

Steps:
1. Colorbers pdf(sce Test Image Files in the Help file) is provided as o helpful test imege
/2. Watch the gray section ofthe color bars image as you- adjust for brightness

Tip:
[Vau may needto go back end forth between brightness and cantzast 2ad Red), Green, and Blue Gain @ for times ta
the optimal result

Suceess connecting and relizving data from FIGE-DY! board 32636132695 DEMDEL

2. On the Wizard, use the File / Open menu and select the supplied resolution
test image file that matches or closely matches the Source PC'’s settings. The
default resolution is 60 Hertz if not indicated. (The settings display along the
bottom of the Wizard dialog box.)

When an image appears on the Destination Monitor:

Proceed to Step 3.
If an image does not appear:

See “Specialized Resolution Adjustments” to the right before continuing.

3.  Transfer the test image files from the Control PC to the Source PC, if you want
to use them.

4. On the Source PC, open the file Colorbars.pdf to display the color bars test
image (for use in Steps 6 and 7).

5. Onthe Source PC, in Acrobat Reader under the View menu, select Actual
Size.

For full warranty information, refer to www.amx.com.
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6. On the Wizard, select Brightness and then Contrast, adjusting each
respectively as you watch the Destination Monitor.

Tip: You may need to go back and forth a few times between Steps 6 and 7 to reach

your desired result.

7. Onthe Wizard, select Red Gain, Green Gain, and Blue Gain, adjusting each
respectively as you watch the Destination Monitor.

8. On the Source PC, open the PDF of the test image that matches your
resolution setting.

9. On the Wizard, select Horizontal Position and then Vertical Position, adjusting
each respectively as you watch the Destination Monitor. (Under the Options
menu, Horizontal Pulse Width may help with this adjustment.)

If the image is not satisfactory:
See “Fine Tune Adjustments” below.

If the image is satisfactory:
Go to Step 10.

10. Select Save As from the File menu.
11.  Enter a file name and click Save.
12. Repeat Step 2 through 11 for each converter that needs adjustment.

Time Saving Tip: The file saved in Step 11 can be opened in Step 2 for other
converters if they are connected to the same type of equipment.

13.  When satisfied, disconnect the Control PC.
14.  On the converter, cycle power to verify that the file was saved correctly.

Options Menu Adjustment ltems (also see Shortcut Keys in Help file)

* Horizontal Pulse Width — increases or decreases the pulse width to shift the
entire picture if the Horizontal Position element cannot move screen far enough.

* Fine Tune Shift — bumps the fine tune configuration element up or down a notch
resetting the Fine Tune, which allows continued adjustments in same direction.

» ReSync Monitor — resyncs the monitor to clear up distortion. Resyncing is useful
as you close in on your final settings.

Specialized Resolution Adjustments
Do not use this section unless the supplied resolution files do not provide an image.
To use specialized adjustments:

1. With the closest resolution file open, increase and decrease Fine Tune Shift*
(under Options menu) several times in each direction until an image appears.
Repeat with all close resolution files if necessary.

If an image does not appear:

2. Repeat the process in Step 1, selecting one of the resolution files from the
sample video card files found at <installation folder>\presets\samples.
If an image still does not appear:

3. Change the Source PC'’s video card settings to match one of the supplied
resolution files and adjust the image accordingly.
Or
On the Wizard (under Options menu), set the resolution and refresh rate to
match the video card settings on the Source PC.

When an image appears:
Resume adjusting the video display at Step 3 in the adjustment procedure in
the column to the left.

* Fine Tune Shift — bumps the fine tune configuration element up or down a notch
resetting the Fine Tune, allowing continued adjustments in the same direction.
CTRL-I (increase) and CTRL-D (decrease) also change the setting.

Fine Tune Adjustments

Use this section if the image requires further adjustment after normal adjustments
have been made.

To fine tune the image:

1. On the Wizard, select and adjust Fine Tune one step at time (click the scroll
bar), watching the vertical noise lines on the Destination Monitor move farther
apart. Stop when the bands disappear. (The picture may still be slightly
distorted; however, the next step should clear any distortion).

2. Under the Options menu, select ReSync Monitor.**

3. Select Phase Timing. As you watch the Destination Monitor, try adjusting it.
If the image does not change, adjustment is not needed.

If the image changed and adjustment is needed, open the PhaseTest.pdf on
the Source PC. Watching the image, adjust until the transitions from dark to
light are even.

4. Resume at Step 10 in the adjustment procedure at the top of this column.

** ReSync Monitor — resyncs the monitor to clear up distortion. Resyncing is useful
as you close in on your final settings. CTRL-R also resyncs the monitor.
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